
    Introduction

Every user has specific needs. Some need an high level of details in their contact data base; some
need information that the programmer may not foresee; other work in an international 
environment and must remember the country and the languages spoken by their users. To make a
long story short, it is truly impossible to build a product that satisfy every need. Aware of that 
IDA decided to build a product that may be personalized by the End-User itself using the 
personalization module.
This guide teach you how to obtain the system YOU need; the system that meet YOURS needs.

Base Notions      
The Generic Controls 
The controls Window by Window



Base Notions

The Personalization module (PM) is started double clicking on the personalization icon of Full 
Contact Program Group. We strongly advise to make a Backup before using it.

To personalise a Form you must:
Select in the Window menu item the window you want to personalise.
Made the modifications
Save them
Repeat that for each window you want to modify
Use the Build option on the File menu to rebuild Full Agenda (Full Contact).

Note that the two empty Forms may be defined at leisure.

Moving/Sizing controls
Adding controls
Modify window caption, menu title, ecc..
Remove Control
Build the system
Order Controls (The TAB order) 
Select a control



Select a control

Click on it or use TAB (SHIFT-TAB). The selected control has a border surrounding it.



Order Controls

The fields TAB order (the order in which the control gain input focus following a TAB) may be 
modified from inside the Personalization Module.
To modify it select Order Control and select as 1 the first control You want to get the input 
Focus; 2 the second and so on. Inside a control the fields will get the input focus from left to 
right from top to bottom.



Moving/Sizing controls 

You may move a control capturing it (click on it) and moving it.
You may size a control selecting it (click on it) and size dragging the border.
You may also move or size a control selecting it and then using left-right-up-down arrows 
(moving) or SHIFT left-right-up-down arrow (sizing).

To help positioning the controls a Grid option is present. 
Selecting this option a dialogue will appear:. You may:

Select the grid density
Eliminate the grid



Adding controls 
Logically connected information are grouped in information blocks. P.e. A person name; his 
Address; his Telephone numbers; his Working hours ecc.. are logical blocks; these blocks are 
called controls.
If you click    near a field, a border is drawn around a group of fields: the control. P.e. if you click
near the From _____ To_____ fields of the contact window, a border is drawn around these two 
fields, they represent the working hours control. The controls may contain many fields (as 
Address does) or just one (as Birth Date).
When you personalise a window you add, remove, size, modify ecc.. the controls contained in 
the window..

To add new controls select one of the menu options listed in the Add Menu item.
When you add a control an empty rectangle appears on the screen; the cursor represents an hand.
Move the cursor, without pressing any button, to the new control position.
Press once the left mouse button

Note: that some of the Add    menu options are grayed. This mean that the control has already 
been inserted in the form an that duplicates are not allowed.

To help positioning the controls a Grid option is present. 
Selecting this option a dialogue will appear:. You may:
Select the grid density
Eliminate the grid

Before moving, sizing, ecc.. a control you must select it; (click near it).

You may:
Move the control: capture it and drag it to the new position.
Delete the control: press the DEL key.
Size the control: capture the border and drag it.
Modify a control: double click on it (or press CR) and fill the dialogue that appears



Modify a control
When you double click on a control, or press return and a control is selected, a dialogue appears.

This dialogue allows to modify the number and behavior of the fields contained in the control.

Normally the dialogue contain a row for each possible control field.
The dialogue normally contains the following columns:
Prs : present must be checked if the control is present.
Label: The label that appears on the left of the field.
Video Dimension: the field length on the screen.
DB Dimension: the field length on the Data Base.
In List : if the field must be used to build the label shown in the father, children or main lists. 
(this column is optional)
Is Combo: if the field is a table (represented as a Combo box) or a normal field. (this column is 
optional).



Modify window caption, menu title, ecc.. 

Double click on an empty window area; a dialogue allows you to modify window caption, menu 
title, internal name (the name used by the import / export utility) and to define which documents  
may be inserted in the document folder. (P.e.    you may decide that notes are not allowed inside a
contact folder).



Delete a Control 

To delete a control Just select it and press the DEL key.



Build the system 
Select the Save / Build option from the main menu



The Generic Controls
Some controls May be added to every document they are:
Not Assigned: Empty fields that must be completely defined by you

Button
Field
Number
Currency
Date
Comment
Combo Box
Label
Multi Button

Miscellaneous
Creation Date 
Modification Date
Vertical Line
Horizontal Line
Exit Button
Spreadsheet
Agenda for
OK Button

Link A
Contact
Note
Appointment
Ext. Document
Customer
Product
Sales Opportunity
Order
Expense



Exit Button

Inserts a Cancel (or Quit) button in the form. This button allows to quit without saving the 
changes.

The button Caption may be modified.
Note the & sign in the caption. The following letter is    the button Hot Key.



OK Button
Inserts an OK button in the form. This button allows to save the form.

The button Caption may be modified.
Note the & sign in the caption. The following letter is    the button Hot Key.



Spreadsheet
It    creates a combo box containing all the files of a specific type (Lotus 1-2-3, Excell, ecc.. ) 
present in the current directory. At the right of the combo a little button
appears. Clicking this button it is possible to start the product for the selected file (p.e. to start 
Lotus 1-2-3 for the file selected in the combo). You may pass data to a
Spreadsheet that is DDE integrated with Full Agenda    (Full Contact) automatically calculating it
with the data inserted in Full Agenda (Full Contact).
Which may select which kind of document (Lotus 1-2-3 instead of Excell instead of ..) must 
appear in the Combo.



Agenda For
It displays in a list all the agenda items contained in the group of the current document.



Multi Button 
A multi radio buttons or check Box buttons control. If you check mutually exclusive is a multi 
radio buttons list if not it is a multi check buttons list.



Link A: 
To insert buttons that automatically create new document in the group of the document you are 
viewing.



The Controls Window by Window
Contact and Agenda items documents have a set of unique controls.

The Contact controls    
The Company controls    
The Agenda Controls
The Products Controls
The Order Controls
The Sales Oppy Controls
The Expense Controls



The Company Controls

Controls that may be added to the order document are:
Generic Controls:
Address: the company address, the address control has country specifics properties; i.e. may be in
USA format (#, street ... ) or in European standard format ( street, #...)
Name: short and long company name.
Telephone: The telephone numbers.

Country Specifics
Italy, Partita Iva: The italian partita Iva.

Financial
Bank: the company bank details
Credit Limit: the company credit limit
Credit Category: the company credit category
Income: the company icome

Sales 
Budget: the assigned budget
To Date: the budget to date
Special Discounts: company special discounts.

Classification
Industry: the company industry classification
Tec. Limit: eventual technological limits to what it is possible to sell to the company.
Growth Potential: the potential for business growth
Special Conditions: possible special conditions
Strategy: the strategy to adopt with the company
Special Proposal Req.: special proposal requirments
Approval level: approval level for contracts
Slogan: the company slogan
Sales points #: number of sales points
Salesmen #: number of salesman
Employees #: number of employees
Large Account: is the company a 'large account'?
Smoke Policy: have the company a smoke policy?
Equal Rights Pol.: have the company a equal rights policy?
CEO Name: what is the company CEO name?
Main Fairs: company main fairs and exhibitions.



Orders Controls

Controls that may be added to the order document are:
Receiving Address: the order receiving address
Billing address: the order billing address
Address: any other order address.
Firm: the firm for which the product has been taken; if the order is in a group this will be 
automatically filled
Products: the list of order items see the order items paragraph
Order Date: the date in which the order has been taken
Print: A button that will print the order.



Order Items

The order items control is pretty complex and may take different behavior;
if you double click over it the following properties form appears:

Quantity Fract: if checked in the quantity field fractional quantity may be inserted (as 2.3 
meters or 1.3 Kgs).
Price Modif.: if checked the price (retrieved from the product DB) may be modified
Discount: if checked the order item will have a discount field.
Item Sales Taxes: if checked the order item will have a sales taxes field
Sales Taxes: if checked is possible to insert order sales taxes.
Total: if checked a total is calculated.
Shipping & handling: if checked will be possible to insert shipping and handling costs.
Order Discount: if checked the order may have a discount field.
Description: if checked an product description is automatically inserted on the order item.



Expenses Controls

Controls that may be added to the expenses document are:
Date: the expense date.
Amount: the expense amount
Why: the expense motivation
Where: where did I spent the money
How: how I paid
Category: in which category is the expense
Due Date: when the expense is due; it is possible to decide is, when the expense is due, a 
reminder has to be automatically inserted in the agenda.



Sales Opp. Controls

Controls that may be added to the Sales Oppy document are:
Hold Till: is the oppy on hold? when I must try again?
History: from who came the oppy; if the oppy is in a company or contact group this field is 
automatically filled; it is possible to fill it with various details.
Value: what is the oppy value?
Probability: what is the probability of closing the oppy?
Strategic: is the oppy strategic?
Lead From: who gave me the lead?
Status: what is the oppy status?
Started: when this oppy started?
Number: what is the oppy number (required field).
Order: has this oppy become an order?



Products Controls

Controls that may be added to the product document are:
Price: product price
Discount: product standard discount.
Sales Taxes: product standard sales taxes.
Description: product description.
Availability: is the product available?
Special Offers: there are special offers?
Stocks: where are the warehouses and how many units they have in stock.
Volume discount: there is a volume discount? and if yes how it is set (P.e. > 10 15%, ecc..)
Available Units: How many units are available? This control will accept +, - keys to 
decrease/increase the number of available units.



Contact Controls
Controls that may be added to the contact document are:
Personal

Name: the contact name THIS CONTROL MUST BE PRESENT; Last Name CAN NOT 
be eliminated.
Salutation: the salutation for this contact; may be a combo box
Address: the contact address. The address control has country specifics properties; i.e. may
be in USA format (#, street ... ) or in European standard format ( street, #...)
Telephone: the contact telephone numbers.
School: which schools the contact attended
Birth Date: the contact birth day
Hobbies: the contact hobbies
Preferences: which hotel, restaurant, ecc.. this person prefer?
Family: the wife, children, ecc.. .Note that if the wife birthday is inserted in the 
Anniversary control an action may be taken upon contact wife's birthday or contact
first children's birthday.
Clubs: the contact clubs.
Languages: winch languages the contact know and how well.

Financial

Bank: contact primary bank.
Credit Limit: the contact credit limit
Credit Category: the contact credit category. Normally is a combo Box.
Yearly Income: The contact yearly income
Investments: which are the contact investments? is a list of 10 different possible 
investments. You may insert investment amount and profitability; the system automatically
calculate the income.

Work

Position: the contact position: years on the job, in the firm ecc..
Call Time: when the contact may be called
Boss: the contact boss name, last name , Tel #
Secretary: the contact secretary name, last name , Tel #
Decision Role: the contact Decision role

Classification

Category: the contact category. Is normally a combo box.
Contacted Through: how the contact was contacted; normally a combo box.
Publications: in which publication the contact is interested; normally    a combo box.
Interested    In: in what the contact is interested; normally a combo box.



Anniversaries: the anniversaries of the contact. You may insert action to be performed 
upon contact birthday, contact wife's birthday, contact children's birthday, Xmas. In the 
agenda a note is added remembering what you decided to do.



The Agenda Controls

Controls that may be added to the contact document are:
Type: the agenda item type. MUST BE PRESENT
Subject: the agenda item subject. MUST BE PRESENT
To Do: if the item is a to do. If not present the To Do windows are not present in Full Agenda 
(Full Contact).
Alarm: Must I tick? and how much before?
Reschedule: if the agenda item is to be reschedule
Comment: a comment field. MUST BE PRESENT
When: time and date of the agenda item. MUST BE PRESENT
Priority: agenda item priority.




